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ABSTRACT

This document outlines the basic hardware and software components for the BOOSTXL-TPS65033 Socketed
Programming Board. The BoosterPack enables pre-assembly programming for both the TPS650320-Q1 and the
TPS65033x-Q1 devices. The TPS65032001-Q1 and TPS65033000-Q1 are re-configurable PMICs for
prototyping various device settings. The settings can then be provided to TI for a final production PMIC.
Alternatively, the TPS65032001-Q1 and TPS65033000-Q1 devices can be programmed in production to match a
wide range of application requirements. The non-safety versions of the TPS650320-Q1 and TPS65033x-Q1 will
similarly allow programming of production units.
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1 BOOSTXL-TPS65033 Components and Environment
The TPS65032001-Q1 and TPS65033x-Q1 family of PMICs are configurable and programmable only through
I2C instructions. The BOOSTXL-TPS65033 socketed board is designed to act as a BoosterPack to the low cost
TI LaunchPads, enabling a LaunchPad to act as the USB-to-I2C interface for communication with a personal
computer. This separation reduces the cost of prototyping and enables experimentation with various TI devices,
including custom software development using existing LaunchPad tools. Many of these tools can be found online
at TI DevTools. The programming GUI is also available in the TI DevTools Gallery. This GUI is compatible with
both the MSP430F5529LP and the MSP432E401Y LaunchPads.

2 BOOSTXL-TPS65033 Board Information
The BOOSTXL-TPS65033 is designed to stack on top of a LaunchPad, connecting the relevant power and MCU
pins to the PMIC through the headers J1/J3 and J2/J4. Power is delivered to the PMIC from the USB port of a
PC through the the LaunchPad 5 V and 3.3 V rails. The following block diagram demonstrates how the
LaunchPad interfaces with the PC and the PMIC.
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Figure 2-1. Programming Board and LaunchPad Connections

2.1 Critical Socketed Board Connections
Critical connections for operating the socketed board are the 5 V rail, the 3.3 V rail, and the I2C pins. The
remaining connections to the LaunchPad are left available for future experimentation. Note: I2C pull-ups must be
pulled up to VIO. This can optionally be pulled up to 3.3 V (default) or an alternate rail through the J12.

By default, the 3.3 V rail must be present to power the VIO and GPIO pins to fully enable the PMIC. If evaluation
without a PC is desired, both the 5 V and the VIO domains should be externally supplied. If VIO is supplied by a
voltage other than 3.3 V, J12 should be left open to prevent potential current paths to the MCU 3.3 V. For most
configurations, the PMIC can supply VIO when externally connected to an appropriate test point, for example the
Buck 1 output if configured for 3.3 V, or the Buck 2 output if configured for 1.8 V.
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2.1.1 Power Switches

Both the 5 V and 3.3 V rails connect to the PMIC through separate current limiting load switches. The load
switches are simultaneously enabled with the S2 toggle switch on the top left area of the board. See Section 5
for the complete BOOSTXL-TPS65033 schematic. It is recommended to keep S2 open when connecting the
LaunchPad to the PC to reduce the initial current draw from the USB port.

2.2 Jumpers and Test Points

Figure 2-2. Programming Board Test Points and Jumpers
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3 Programming GUI Operation
3.1 Initial Set-up
3.1.1 Finding the GUI

The Graphical User Interface (GUI) for the BOOSTXL-TPS65033 can be found in the Gallery at TI DevTools.
This GUI will connect to the BOOSXL-TPS65033 provided a compatible I2C controller is connected
(MSP430F5529LP, MSP432E401Y, or USB2ANY). This GUI is also compatible with the TPS650320Q1EVM and
TPS650330Q1EVM, which both have on-board MSP432E401Y MCUs.

The GUI can be operated through Google Chrome™ or Mozilla Firefox™ web browsers. To run the GUI in the
browser, click the thumbnail and follow the prompted instructions for first time installation. The GUI requires both
a browser plugin and the TI Cloud Agent software for access to the local USB ports. The GUI can also be
downloaded for offline operation by hovering over the downward arrow in the GUI thumbnail and selecting the
desired platform – Windows®, macOS®, or Linux®.

3.1.2 Offline Installation

To download the offline installer, click the downward arrow on the below the thumbnail and select the relevant
operating system for the destination PC.

Figure 3-1. Standalone Installer Download Icon

The platform downloads will include the GUI Composer runtime installer if internet access is available during
installation. If the PC has no internet access at time of installation, the runtime installer may need to be
downloaded in advance using the additional links below the platform installation URLs.

Figure 3-2. Standalone Installer Operating System Options

www.ti.com Programming GUI Operation

SLVUBO3A – APRIL 2019 – REVISED OCTOBER 2020
Submit Document Feedback

BOOSTXL-TPS65033 User's Guide 5

Copyright © 2020 Texas Instruments Incorporated

https://dev.ti.com/gallery/info/TPS6503xx/TPS6503xx-Q1_GUI/ver/1.0.0/
https://dev.ti.com/
http://www.ti.com/tool/MSP-EXP430F5529LP
https://www.ti.com/tool/MSP-EXP432E401Y
https://www.ti.com/tool/USB2ANY
https://www.ti.com/tool/TPS650320Q1EVM
https://www.ti.com/tool/TPS650330Q1EVM
https://www.ti.com
https://www.ti.com/feedbackform/techdocfeedback?litnum=SLVUBO3A&partnum=


3.1.3 Flashing the MSP430F5529 LaunchPad

Initial operation with the MSP430F5529 LaunchPad requires downloading pre-configured firmware into the
MSP430 in order to be recognized by the GUI.

The GUI incorporates a tool to flash the MSP430F5529 LaunchPad, located under the File tab in the top menu.
This tool is pre-configured to flash the MSP430F5529LP only, and cannot be used with other LaunchPads.

Figure 3-3. LaunchPad Firmware Flashing Tool

To flash the LaunchPad, first connect the MSP430F5529LP to the PC using a micro-USB cable, then select File
> Program Device. The GUI will automatically download the firmware, recognize the LaunchPad, and flash the
board.

Afterwards the LaunchPad will be recognized as the specific USB-to-I2C interface for operating with the
TPS65032001-Q1 and TPS65033x-Q1 PMICs.

3.1.4 Flashing the MSP432E401Y Launch Pad

Initial operation with the MSP432E401Y LaunchPad requires downloading pre-configured firmware into the
MSP432 in order to be recognized by the GUI. See Section 3.1.2 about how this firmware must be accessed by
installing the GUI for offline operation.

1. Once downloaded, the MSP432 firmware file, acctrl_4_18.bin, can be found at:{Installation
Directory}\install_image_TPS6503xx-Q1_GUI.zip\TPS6503xx-Q1_GUI\app\firmware

2. Install UniFlash, a free firmware flashing tool from TI.
3. Connect the LaunchPad to the PC. Use the USB port on the MSP432E401Y LaunchPad that is opposite the

Ethernet port.
4. Run UniFlash. The program should automatically detect the connected MSP432E401Y LaunchPad. Once

detected, click Start.
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Figure 3-4. UniFlash Initial Setup
5. On the next page, browse to the binary file downloaded in Step 1 and click Load Image.

Figure 3-5. UniFlash Load Firmware Image
6. If prompted, update the XDS110 Debugger firmware. After accepting the update, UniFlash will update the

firmware automatically and continue to load the binary image. The console will indicate a successful program.
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Figure 3-6. UniFlash Successful Program
7. Unplug the micro USB cable from the MSP432E401Y LaunchPad.
8. Now plug the USB cable in to the micro USB port adjacent to the Ethernet port.
9. Install jumper on pins 3-4 (USB-OTG) of JP1 to supply the target 5 V supply through USB.

After completing this process, the GUI will recognize the LaunchPad as a USB-to-I2C interface. Next, stack the
BOOSTXL-TPS65033 on top of the MSP432E401Y LaunchPad. The headers should align according to Table
3-1.

Table 3-1. BoosterPack to MSP432E401Y LaunchPad Connections
BOOSTXL-TPS65033 Pin Header MSP432E401Y LaunchPad Pin Header

J1 J5

J2 J6

J3 J7

J4 J8

Note there may be two separate interfaces (or COM ports) recognized by the GUI. If one is failing to connect,
use the GUI to switch to an alternate port.

1. Click the Options menu at the top of the GUI, select Serial Port.

Figure 3-7. Serial Port Options
2. Use the Ports dropdown to select the alternative interface.
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Figure 3-8. GUI Serial Port Selection
3. The GUI will indicate a successful connection through the black connection toolbar.

Figure 3-9. Hardware Connected Indicator

3.2 Connection Debugging
The connection link in the black toolbar at the bottom of the GUI can be toggled to refresh the connection to the
LaunchPad. The flow chart in Figure 3-11 can aid in debugging potential connection issues with the BOOSTXL-
TPS65033.

Figure 3-10. Refreshing the GUI-to-MCU Connection
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Figure 3-11. BOOSTXL-TPS65033 Connection Debug Flow Chart

3.3 Basic Operation of the GUI
The GUI displays a README.md prompt each time the GUI is launched. The prompt can be disabled for
subsequent sessions by selecting the I checkbox at the bottom of the window. The README.md information is
always available in the Help tab at the top of the GUI.

The GUI automatically attempts to connect to the flashed LaunchPad, with the connection status displayed in the
bottom left hand corner of the GUI window. Once connected to the LaunchPad, the GUI attempts to read the
register information of the PMIC populated in the socket. If the PMIC appears unresponsive, verify the serial port
connection and confirm that all relevant shunts are populated according to Figure 2-2. If all shunts are populated
properly, pressing the RST button on the LaunchPad (S3) below the socketed board can often recover USB
communication.

3.3.1 Home

The Home section is the landing page of the GUI. Here the GUI presents an overview of the EVM and
Programming BoosterPack (BOOSTXL-TPS65033), and emphasize navigation to the remaining four sections
through the tiles on the bottom of the page.
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Figure 3-12. TPS6503xx-Q1 GUI Home Screen

3.3.2 Block Diagram

The Block Diagram section displays the typical components and functional blocks of the PMIC. A block diagram
for the Programming BoosterPack is also shown.

Figure 3-13. TPS6503xx-Q1 GUI Block Diagram Page

3.3.3 Registers

The Registers section provides an overview of the internal register map, and includes basic interfaces for each
PMIC register. Figure 3-14 illustrates the register page and the primary interactive regions.
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Figure 3-14. Register Page Interfaces

The register table displays each register name, address, last known value from the PMIC, and corresponding bit
values. Selecting a title or bit fields in the table will update the Field View column on the right side of the GUI.
The Field View displays the individual fields contained within the associated register address. Within the register
page, clicking a blue icon containing a question mark (?) will expand additional descriptions if available. The
expanded description views can then be closed by clicking the red (x) icon.

This register page can poll the device periodically using the Auto Read feature in the top right corner, or allow
manual read instructions using the Read Register and Read All Registers buttons.

A drop-down menu selection at the top right of the register map indicates how the registers are written as the
user interacts with the register page. With Immediate selected, any update to the register page is automatically
sent to the PMIC, whereas Deferred will wait for the Write Register or Write All Registers instructions before
communicating with the device. After each write, the register page will automatically read the affected register
address to confirm the latest value in the device.

3.3.4 Device Configuration

The Device Configuration section is organized into selectable tabs at the top of the page, where only the
contents of the blue tab is actively displayed. Each tab contains categorized visual instruments relating to
individual bit fields within the register map. Each instrument is linked to the latest bit values in the register map
table, and can be used to alter settings within the PMIC through the dropdown menus or check box features. If
the Auto Read function in the register map is inactive, the Read All Registers button in the top right area of the
Device Configuration page can be used to manually refresh the register page, which will then update the
instruments with the latest device values.

The PMIC incorporates Control Lock and Configuration Lock features that can prevent I2C writes to various
registers within the device. The status of these locks will always be displayed in the top right hand corner of the
Device Configurations page, and can be toggled by clicking their associated checkbox. When the GUI is properly
connected to the EVM and write instructions appear to be ignored by the PMIC, confirm the status of these
indicators to verify the device is able to accept new write instructions.

Programming GUI Operation www.ti.com

12 BOOSTXL-TPS65033 User's Guide SLVUBO3A – APRIL 2019 – REVISED OCTOBER 2020
Submit Document Feedback

Copyright © 2020 Texas Instruments Incorporated

https://www.ti.com
https://www.ti.com/feedbackform/techdocfeedback?litnum=SLVUBO3A&partnum=


Figure 3-15. TPS6503xx-Q1 GUI Device Configuration Page

3.3.4.1 Using Device Configuration to Define Spin Settings

In some circumstances, TI may provide customized, pre-programmed devices for the camera application.
Contact a local TI sales representative for more information.

The Device Configuration tabs in the GUI can be used to define custom settings for TI to pre-program into the
device Non-Volatile Memory (NVM). Before beginning the spin definition, see the Camera PMIC Spin Selection
Guide to determine if there is an exisiting spin that is already compatible with the target application and the
image sensor or both.

Since the visual instruments in the Device Configuration page link directly to the corresponding bits and registers
in the Register Map page, the Device Configuration page can be used to quickly define desired OTP register
settings.

1. Select the desired camera PMIC from the drop-down menu above the tab indicators to start. The GUI will
automatically show, hide, or disable features corresponding to the selected PMIC. This drop down box will not
be adjustable if a device is connected to the GUI.
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Figure 3-16. Device Selection for Generating NVM Settings
2. Select the desired regulator, sequencing, and additional feature settings in each of the tabs. These changes

will be reflected in the Register Map page. For determining the power sequence settings, see Section 3.3.4.2.
3. Click File > Save Settings in the top left corner of the GUI. This exports the register settings in a JSON file

that is provided to generate the NVM spin.

Figure 3-17. Example Settings Output

3.3.4.2 Configuring the Power Sequence

The Sequencing Overview tab includes instruments to customize the power sequence of the PMIC. Note that the
check boxes are power sequence masks. If a particular logic signal needs to be included as part of the regulator
or logic power up sequence, leave the box next to the logic signal unchecked. TI recommends to set Power On
Bit unmasked for each rail that is required in the application.
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Figure 3-18. Sequencing Overview Tab

When using a TPS65033x-Q1 device, the GPIO pin can also be used for power sequencing of an external
regulator or other device. In the Special Features tab, configure GPIO as an output to include its sequencing in
the Sequencing Overview tab. Note that when using GPIO for sequencing, the GPIO Function must be Enabled.

Figure 3-19. Sequencing Overview Including GPIO

For reference, the GUI can generate example power-up and power-down timing diagrams based on the
sequence settings present when the UPDATE TIMING DIAGRAM button is clicked. As noted, rise and fall times
are approximate, and the maximum sequence length is 200 ms. Changes to regulator enable and output
discharge settings are reflected in the timing diagram. If the sequence settings are not valid, the GUI will provide
a notifying message and the timing diagram will not be updated. For example, if a regulator is enabled but fails
to power-up within 200 ms, the sequence settings are not valid.
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Figure 3-20. GUI Generated Timing Diagram

3.4 Scripting
The GUI includes a scripting feature in the tools menu at the top of the window. Scripting enables automated
writes and reads to the PMIC, allowing sequential instructions to be sent to the PMIC. Scripts can be saved as
a .js or .txt file, and imported using the Upload arrow at the top of the scripting window. Scripting allows the re-
configuration of multiple PMICs before sending to assembly or populating on a PCB.

Figure 3-21. TPS6503xx-Q1 GUI Scripting Window
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An example script for re-programming a device can be seen below, where output voltages and sequencing
settings are reconfigured from the default settings.

/* Entry point for the script, which will be executed when the user presses the PLAY button in the 
Scripting Dialog. */
function main() {
write('CONTROL_LOCK', 0xDD);     // Unlock control registers
write('CONFIG_LOCK', 0xAA);      // Unlock configuration registers
write('GPIO_CTRL',2);            // Disable configuration CRC
write('BUCK_LDO_CTRL',0x00);     // Turn off all regulators to prevent faults
write('BUCK3_VOUT',6);           // Change Buck 3 output voltage
write('LDO_VOUT',8);             // Change LDO output voltage
write('SEQ_TRIG_BUCK2',10);      // Update Buck 2 sequence dependencies
write('SEQ_TRIG_BUCK3',2);       // Update Buck 3 sequence dependencies
write('SEQ_TRIG_LDO',26);        // Update LDO sequence dependencies
write('SEQ_TRIG_nRSTOUT',2);     // Update nRSTOUT sequence dependencies
write('BUCK1_SEQ_DLY',145);      // Update Buck 1 sequence delay
write('BUCK2_SEQ_DLY',86);       // Update Buck 2 sequence delay
write('BUCK3_SEQ_DLY',54);       // Update Buck 3 sequence delay
write('LDO_SEQ_DLY',118);        // Update LDO sequence delay
write('nRSTOUT_SEQ_DLY',6);      // Update nRSTOUT sequence delay
write('BUCK_LDO_CTRL',31);       // Re-enable all regulators
write('EEPROM_PROG_CMD',45);     // Burn settings into EEPROM
}

Figure 3-22 details the typical device programming flow. Most blocks can be executed with one or more register
write commands in the script file. Only the J2 configuration and GPIO trigger application cannot be done via
scripting.
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Figure 3-22. Example Script Program Flow

Programming GUI Operation www.ti.com

18 BOOSTXL-TPS65033 User's Guide SLVUBO3A – APRIL 2019 – REVISED OCTOBER 2020
Submit Document Feedback

Copyright © 2020 Texas Instruments Incorporated

https://www.ti.com
https://www.ti.com/feedbackform/techdocfeedback?litnum=SLVUBO3A&partnum=


4 Recommended Operating Procedure

• Due to the parasitic elements introduced by the BOOSTXL-TPS65033 socket, it is recommended
to use the BOOSTXL-TPS65033 board primarily for digital evaluation. This includes features like
NVM programming, state machine behavior, diagnostics, and fault handling.

• For analog performance evaluation of the PMIC, please refer to the TPS650320-Q1 EVM and the
TPS650330-Q1 EVM.

1. Connect the socketed board to the MSP430F5529 LaunchPad by aligning placing the socketed board on top
of the LaunchPad, aligning the J1/J3 and J2/J4 headers, and pressing the two boards together. For the
MSP432E401Y, align with the J5/J7 and J6/J8 headers.

2. Ensure S1, S2, and S3 of the socketed board are not asserted (down position), and connect the LaunchPad
to the PC using a micro-USB cable. A TPS65032001-Q1 or TPS65033x-Q1 device may be inserted into the
socket at any time that S2 is open and proper ESD considerations are observed. Ensure the unit's Pin 1
indicator is aligned with the Pin 1 silkscreen indicator on the lower left corner of the socketed board.

3. Ensure the Device Selection jumper (J2) matches the generic part number of the device populated in the
socket.

4. If this is the first time using the LaunchPad with the TPS6503xx-Q1 GUI, flash the LaunchPad using the steps
outlined in Section 3.1.3 or Section 3.1.4. This will permanently configure the LaunchPad to act as a USB-to-
I2C adapter and will not be necessary for subsequent sessions.

5. Set S2 to the active position. The D1 LED will indicate when power is supplied to the socket.
6. Verify the connection status of the adapter in the bottom left corner of the GUI window. If Hardware not

Connected is displayed, toggle the connection icon once to refresh the adapter connection. With the D1 LED
active and the adapter recognized by the GUI, I2C communication should be available to the PMIC. The
adapter will disconnect if I2C communication fails. Verify that the I2C pull-up voltage is available (J12 and
VIO test point) if the GUI consistently disconnects after read or write attempts.

7. Navigate to the Register Map or Device Configuration page, and select the Read All Registers button in the
top right corner of the GUI window.

8. The Register Map will populate with the returned values as the PMIC replies to the I2C read requests. The
Register Map can directly interact with the PMIC through drop down menus for each register field or by
directly writing into the value column for the individual registers. For a graphical representation of common
device settings, select the slider icon below the pencil icon in the left toolbar to navigate to the Device
Configuration view. These visual indicators are linked directly to the respective bits or bitfields in the register
map.

9. Selecting the tabs at the top of the Device Configuration view will navigate through the categorized register
fields.

10.By default, the Control and Configuration registers of the PMIC are always locked after a re-start event,
preventing accidental I2C writes to the device. The check-boxes in the top right corner of the Device
Configuration view can verify if critical registers are accepting write instructions from the I2C master. These
check boxes can also be used to lock and unlock the associated registers.

11.By default, certain regulators are dependent on either the status of SEQ (S1), or the status of SEQ and GPIO
(S3). All sequencing dependencies are visible in the regulator's respective tab, or by using the Sequencing
Overview tab within the Device Configuration view.

12.When registers are unlocked, any changes to the device registers will take effect immediately.
13.The PMIC will always return to default settings if a fault occurs that forces a transition to the RESET state.
14.Register changes will not be stored in EEPROM unless the programming instruction has been sent to the

PMIC through the I2C.
15.The EEPROM is programmed when a hex value of 0x2D is written to register 0x4A. In the GUI, this can be

done directly through the register map or by clicking the Flash EEPROM button in the Re-Program PMIC
view of the GUI.
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5 BOOSTXL-TPS65033 Schematic
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6 BOOSTXL-TPS65033 Board Layers

Figure 6-1. Top Layer
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Figure 6-2. Mid-Layer 1
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Figure 6-3. Mid-Layer 2
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Figure 6-4. Bottom Layer (Mirrored)
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7 BOOSTXL-TPS65033 Bill of Materials
Table 7-1. BOOSTXL-TPS65033 Bill of Materials (BOM)

Designator Quantity Value Description Package Reference Part Number Manufacturer
!PCB1 1 Printed Circuit Board BMC059 Any

C1, C7 2 1 µF CAP, CERM, 1 µF, 35 V, ±
20%, X5R, 0402

0402 GRM155R6YA105ME1
1D

MuRata

C2 1 150 µF CAP, TA, 150 µF, 6.3 V, ±
20%, 0.025 Ω, SMD

3528-21 T520B157M006ATE025 Kemet

C3, C6 2 0.1 µF CAP, CERM, 0.1 µF, 10 V,
± 20%, X5R, 0402

0402 885012105010 Wurth Elektronik

C4, C5, C11,
C14

4 10 µF CAP, CERM, 10 µF, 10 V,
± 20%, X5R, 0402

0402 CL05A106MP5NUNC Samsung Electro-
Mechanics

C8 1 0.1 µF CAP, CERM, 0.1 µF, 50 V,
± 20%, X7R, AEC-Q200
Grade 1, 0402

0402 CGA2B3X7R1H104M0
50BB

TDK

C9, C12,
C13

3 10 µF CAP, CERM, 10 µF, 25 V,
± 20%, X7R, AEC-Q200
Grade 1, 1210

1210 CGA6P1X7R1E106M2
50AC

TDK

C10 1 10 µF CAP, CERM, 10 µF, 10 V,±
20%, X7R, AEC-Q200
Grade 1, 1206

1206 LMK316AB7106MLHT Taiyo Yuden

C15, C17 2 10 µF CAP, CERM, 10 µF, 6.3
V,± 10%, X7R, AEC-Q200
Grade 1, 0805

0805 JMJ212CB7106KGHT Taiyo Yuden

C16, C18,
C19, C20

4 1 µF CAP, CERM, 1 µF, 10 V, ±
10%, X7R, AEC-Q200
Grade 1, 0603

0603 LMK107B7105KAHT Taiyo Yuden

D1 1 Green LED, Green, SMD 0.8x1.6 mm HSMG-C190 Avago

H1 1 IC to place in Socket XU1 TPS650330QRGEQ1 Texas Instruments

J1 1 Header, 100 mil, 2x1, Tin,
TH

Header 2x1 90120-0122 Molex

J2 1 Header, 100 mil, 3x2, Tin,
TH

3x2 Header PEC03DAAN Sullins Connector
Solutions

J3, J4 2 Receptacle, 2.54 mm,
10x2, Tin, TH

10x2 Receptacle SSQ-110-03-T-D Samtec

J5, J12 2 Header, 100 mil, 2x1, Tin,
TH

Header, 2 PIN, 100 mil,
Tin

PEC02SAAN Sullins Connector
Solutions

J7, J9 2 Header, 100 mil, 3x1,
Gold, TH

PBC03SAAN PBC03SAAN Sullins Connector
Solutions

J11 1 Header, 100 mil, 4x2, Tin,
TH

Header, 4x2, 100 mil, Tin PEC04DAAN Sullins Connector
Solutions

L1 1 1.5 µH Inductor, Shielded, Metal
Composite, 1.5 µH, 2.3 A,
0.11 Ω, AEC-Q200 Grade
0, SMD

0806 TFM201610ALMA1R5
MTAA

TDK

L3, L4 2 1 µH Inductor, 1 µH, 3.1 A, 0.06
Ω, SMD

2.0x1.6x1.0 mm TFM201610GHM-1R0
MTAA

TDK

Q1 1 25 V MOSFET, N-CH, 25 V, 5
A, DQK0006C (WSON-6)

DQK0006C CSD16301Q2 Texas Instruments

R1, R2 2 100 k RES, 100 k, 5%, 0.1 W,
AEC-Q200 Grade 0, 0603

0603 CRCW0603100KJNEA Vishay-Dale

R3 1 1.5 k RES, 1.5 k, 5%, 0.063 W,
AEC-Q200 Grade 0, 0402

0402 CRCW04021K50JNED Vishay-Dale

R4 1 680 RES, 680, 5%, 0.1 W,
0603

0603 RC0603JR-07680RL Yageo

R5, R6 2 4.7k RES, 4.7 k, 5%, 0.1 W,
0603

0603 RC0603JR-074K7L Yageo
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Table 7-1. BOOSTXL-TPS65033 Bill of Materials (BOM) (continued)
Designator Quantity Value Description Package Reference Part Number Manufacturer
R7, R8, R9 3 0 RES, 0, 5%, 0.063 W,

0402
0402 RC0402JR-070RL Yageo America

S1, S3 2 Switch, Slide, SPDT, On-
Off-On, 3 Pos, 0.05 A, 48
V, TH

9.5x5 mm AS1E-2M-10-Z Copal Electronics

S2 1 Switch, Slide, SPDT, 0.2
A, J Lead, SMD

SMD, 3-Leads, Body
8.5x3.5 mm, Pitch 2.5 mm

CL-SB-12A-01T Copal Electronics

SH-J1, SH-
J2, SH-J3,
SH-J4, SH-
J5, SH-J6,
SH-J7, SH-
J8

8 1x2 Shunt, 100 mil, Flash
Gold, Black

Closed Top 100 mil Shunt SPC02SYAN Sullins Connector
Solutions

TP1, TP2,
TP3, TP4,
TP5, TP6,
TP7, TP8,
TP9, TP10,
TP11, TP12,
TP13, TP14,
TP15, TP16,
TP17, TP18

18 PCB Pin, Swage Mount,
TH

PCB Pin(2505-2) 2505-2-00-44-00-00-07-
0

mill-Max

U1, U2 2 5.5 V, 2 A, 38 mΩ Load
Switch With Quick Output
Discharge, YFP0004AAAA
(DSBGA-4)

YFP0004AAAA TPS22915CYFPR Texas Instruments

XU1 1 Socket, QFN-24, 0.5 mm
Pitch

Socket, QFN-24, 0.5 mm
Pitch

QFN-24BT-0.5-01-00 Enplas Tech Solutions
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8 Revision History
NOTE: Page numbers for previous revisions may differ from page numbers in the current version.
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